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a summary of what you did or didn’t fi nd; the related person 
or family and where they lived; notations and source cita-
tions; and comments about your search strategies, sugges-
tions, questions, analyses and discrepancies. You can use 
this important tool to organize and track your research, to 
prepare for a research trip or to pick back up after a break. 
Just follow these six steps.  

1
Decide on a format.
You’ll want to set up your research log using a tool that 

lets you sort the data by each column (so you could, say, fi nd 
all of the entries related to the library you’re visiting next 
week) and search for a term such as a name or year. Depend-
ing on the extent of your research, you also might want the 
flexibility to set up separate tabs for different ancestors, 
branches of your tree or record groups. You could also set up 
one family per workbook and assign each ancestor a diff erent 
sheet. Database software such as Microsoft Excel is a simple 
way to keep your research log. You probably already have it 
on your computer and are familiar with how it works. 

If you keep your spreadsheet in the “cloud” with a tool 
such as Google Drive <drive.google.com> (the new home for 

Logging On
Does your genealogy search feel a bit scattered? 

Whip it into organized, effi  cient shape by using a research log. 
Our expert shows you how to get started.
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BEGINNER TO ADVANCED

3  AS THE SAYING goes, “You can’t know where you’re 
going until you know where you’ve been.” In the course of 
your research, you probably talk with relatives, use online 
databases and websites, visit repositories to scour books and 
microfi lm, and yes, sometimes even send away for records via 
mail. You might collect plenty of data for each ancestor, but 
usually each answer leads to more questions. Keeping track of 
it all so you can pick up where you left off  and avoid recheck-
ing the same sources gets challenging. The best way I’ve found 
to manage my searching is to record my research to-dos and 
have-dones in a simple spreadsheet—a research log.

A log is a comprehensive list of sources you’ve already 
searched or plan to search, including the pur-

pose of each search (what you want to fi nd); 
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Google Docs) or Evernote <evernote.
com>, you’ll be able to use it from the 
library, great-aunt Edna’s house, or 
wherever you happen to have internet 
access. Here I’ll show you how to set up 
your log using Google Drive. 

If you want to set up your log in Excel, 
you can upload it into Google Drive for 
later editing and anywhere-access. You 
also can set up Google Drive to sync 
with files on your hard drive, so you 
could edit the file at home and still 
access an updated version online. In 
Evernote, you can attach an Excel fi le 
to a new note.

2
Consider columns.
Think about your research and 

plan out the columns you’ll want in your 
research log. It’s better to start with 
too-specifi c columns you can combine 
or delete later than to be months into 
your log and realize you should’ve been 
recording a particular bit of data all 
along. Here’s what I suggest recording 
for each research log entry:

 DATE ENTERED: Note the date you 
enter the item into your to-do list.

 GIVEN NAME: Record the fi rst and 
middle name of the person who’s the 
subject of this entry.

 SURNAME: Enter the relative’s sur-
name (include a woman’s maiden and 
married names in case she used one or 
the other in the record you’re seeking).

 RECORD OR RESOURCE: Enter the 
title, date and other details for the 
resource you’re seeking. 

 INFORMATION SOUGHT: Note what 
you’re looking for.

 REPOSITORY/WEBSITE: Record the archive or website you 
need to visit to complete the task. Include contact informa-
tion such as URLs and phone numbers.

 DATE COMPLETED: Leave this column blank until you 
check the item off  your to-do list.

 OUTCOME: Note whether your search was successful and 
what you discovered once you complete the item.

 SOURCE CITATION: Compose a source citation you can 
copy and paste into your genealogy software once you con-
sult the resource.

 SOURCE NUMBER: If you number your sources according 
to a fi ling system, you can enter that number here.

 NOTES: Add any other helpful information about the per-
son, repository or record.

Every genealogist researches diff erently, so no two gene-
alogists’ research logs will look entirely the same. For addi-
tional column ideas and examples, see the box on page 27.  

3
Create a new document.
For Google Drive, fi rst log in in to your Gmail account. 

If you don’t have one, set it up for free following the steps at 
<accounts.google.com>. Next, click on Drive or go to <drive.
google.com> and then click the red Create button. A list of 
document types will drop down; select Spreadsheet. Next, 
give your spreadsheet a title: Click Untitled Spreadsheet at 
the top, then rename the spreadsheet. You could go with 
something simple such as “Lisa’s Genealogy Research Log,” 
or use the name of the family or person who’s the focus of 
this log (for example, “Jan Alzo”).

3

4

1 2
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and/or name column to stay put as you scroll down or across 
the sheet, highlight those cells and go to View>Freeze Rows 
or Freeze Columns.  

You can customize the appearance of your research log 
in many ways. You can change the font size by highlighting 
the text you want to change (click the rectangle at the top 
right of the spreadsheet to select everything) and going to 
Format>Font Size. To change the font color, highlight the 

4
Share if you want to. 
Google Drive permits sharing, 

great if you’re collaborating with cous-
ins on your research or you want to 
keep family updated on your progress. 
(Evernote and similar tools also let you 
share your logs.) Click File and then 
Share, and review the privacy policy. 
The default setting is Private. If you 
want to share your log with a family 
member or genealogy pal, click Change. 
Under Sharing Settings, set your vis-
ibility options to Public on the Web 
(makes the log viewable by anyone) or 
Anyone with the Link (only those who 
receive the link to your log can see it). 
Click Save. Click the Learn More link 
to get more details on these visibility 
options. If you change your mind, you 
can always return to these settings and 
choose Private.

To email others a link to your research 
log, go to the Sharing Settings page by 
clicking on the blue Share icon in the 
top right corner of your spreadsheet, 
enter the email addresses, then check 
the box to send out emails. You also can 
add a message to your email and desig-
nate recipients as editors (“can edit”) or 
readers (“can view”).

5
Set up your log. 
In the fi rst row of your spreadsheet, type the title of 

your research log—if desired, you can make it longer than the 
fi le name you used in step 3, or add identifying details such as 
life dates. For easier readability, I like to skip a few rows and 
then start adding headings for my columns. I also boldface 
my column headings so they’ll stand out. To do this, highlight 
the row by clicking on the row number on the left and then 
click the bold B in the toolbar. To “freeze” the header row 

MORE
ONLINE

ShopFamilyTree.com
 Research Logs for the Rest of Us 

video class <shopfamilytree.com/
research-logs-for-rest-of-us-
video-class-u4146>

 Build Your Research Toolbox 
video class <shopfamilytree.
com/build-your-research-
toolbox-w8715>

 Organize Your Genealogy 
Life! CD <shopfamilytree.com/
organize-your-genealogy-life-cd>

Free Web Content
 Research log tips from the virtual genealogy 

conference <blog.familytreemagazine.com/
insider/2012/10/03ResearchLogs
TipsFromTheVirtualGenealogy
Conference.aspx>

 Downloadable forms: Research trackers and 
organizers <familytreemagazine.com/info/
researchforms> 

 How to use a research log <familytreemagazine.
com/article/how-to-use-a-research-log>

For Plus Members
 Keeping a research journal 

<familytreemagazine.com/
article/the-write-way>

 Keys to avoid 
research mistakes 
<familytreemagazine.com/
article/9-keys-to-stay-on-
track>

 Build your genealogy fi tness 
<familytreemagazine.com/
article/shaping-up> 

5

6
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the repository (the county courthouse) and information 
needed (for example, the date and grounds for divorce). In 
the Notes column, you could enter source information from 
the newspaper article you found, including the date, which 
will help you locate the divorce petition.

Next time you have a few minutes, check your log for online 
searches you can do. If you’re going to the library, sort the 
Repository column for the library name to fi nd all the geneal-
ogy tasks you want to do there (to sort a Google spreadsheet, 
click the arrow at the top of the column you want to sort by 
and select Sort Sheet A-Z or Sort Sheet Z-A). Can’t remember 
whether you’ve already searched for your ancestor’s birth 
certifi cate in Ancestry.com’s birth records collection? Run a 
keyword search for the ancestor’s name. 

Whether it’s in Excel, Google Drive or another program, 
you can customize your log to your research needs and use 
it in an endless number of ways. Once you settle on a system 
that works for you, you’ll make the most effi  cient use of your 
precious research time. With a research log, you can search 
with a purpose. 

Lisa A . Alzo  is an instructor for Family Tree University 
<familytreeuniversity.com>, with courses including Organizing 
Your Genealogy, Time Management for Genealogists and sev-
eral ethnic heritage classes.

words and click the Text Color button on the toolbar (the 
A with a dark line under it). You also can change the back-
ground color of a row or cell—say, yellow for a census record, 
pink for a church record and so on—by selecting the row or 
cell and clicking the Text Background Color button (the A 
with a light under it). In both the Text Color and the Text 
Background Color boxes, you can choose Conditional For-
matting to set the color to automatically change when you 
type certain words. For example, you could make a row turn 
light blue if you put a big X in your Date Completed column.

You can label this sheet’s bottom tab, especially helpful 
if you plan to create multiple sheets in this workbook. Just 
click on Sheet 1 in the bottom left corner and choose Rename. 
Type the sheet name and hit OK. If you need help with a 
specifi c feature or with formatting, click on the Help tab for 
the Docs Help Center, User Forum and Docs Community on 
Google+. Also look for the handy Function List and Keyboard 
Shortcuts. For a guide to other features in Google spread-
sheets, see the guide at <support.google.com/drive/bin/topic.
py?hl=en&topic=2811806>. 

6
Maintain your log. 
This is the most important step of all—your log is no 

good if you don’t use it. Start with your current research 
to-do list: What records do you need to look for to fi ll in holes 
in your family tree? Enter information for each record into 
your spreadsheet.

No to-do list? Take the opportunity to review one of your 
research brick walls and brainstorm records that might help 
you solve it. Put those into your research log. Next, review 
your research for missing records. Do you have a death 
record for every family member? Have you found a WWI 
draft registration card for every male ancestor age 18 through 
45 in 1917 and 1918? Did you search for every post-1961 death 
in the Social Security Death Index (available on FamilySe-
arch.org <www.familysearch.org>)? If not, add these searches 
to your to-do list.

Keep the log open on your computer or with you in printed 
form whenever you do genealogy research. As soon as your 
search inspires another to-do, add it to your log before you 
forget about it. Say a newspaper society column reports that 
your great-great-grandmother filed a divorce petition in 
court. You’d immediately fi ll in a row with today’s date, your 
great-great-grandmother’s name, the type of record (“divorce 
petition”) and date of fi ling (as reported in the newspaper), 

TIP: If you keep your research log in the cloud, you can 
download apps that let you access it from your smart phone. 

Google Drive and Evernote have free apps for iPhone and 
Android platforms. You also can open spreadsheets with apps 
such as iSpreadsheet (iPhone) and QuickOffice Pro (Android).

Getting a Log Up
These how-tos from experienced genealogists will supply 
plenty of inspiration for setting up and using your genealogy 
research log: 

  Creating a Research Log: The Whys and How
<elysesgenealogyblog.com/
creating-a-research-log-the-why-how>
  Geni Podcast: Genealogy Research Logs
<www.geni.com/blog/geni-podcast-genealogy-
research-logs-369091.html>
  How to Use Excel for Genealogy
<www.ehow.com/how_8342679_use-excel-
genealogy.html#ixzz27hsbF100>
  In Which I Stop the Madness and Start the Research 
Logging <rainydayreadings.blogspot.com/2011/10/
in-which-i-stop-madness-and-start.html>

  Miriam’s Census Spreadsheet
<tinyurl.com/censusMiriam>
  Working It Wednesday: Timeline in Excel (Part 1) 
<theshygenealogist.wordpress.com/2010/04/21/
working-it-wednesday-timeline-in-excel-part-1>
  Working It Wednesday: Timeline in Excel (Part 2)
<theshygenealogist.wordpress.com/2010/04/23/
timeline-in-excel-part-2>
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